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1 Overview

This manual describes installing and upgrading the TrueAllele® Visual User Interface
(VUler™) software, and provides information about network and backup systems.
The basics of starting the program, connecting to a database, and a glossary of

common terms are also available in this manual.

The first two sections of this overview discuss the basics of the DNA interpretation
process and where additional educational material is found. This information is

useful for understanding how TrueAllele works.

The VUler section gives information about the software options available for use

with TrueAllele. VUler allows the analyst to interact with the TrueAllele server.

The System Requirements section gives the recommended system requirements for
optimal use of the TrueAllele VUler software. Minimum system requirements are

also supplied.
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1.1 DNA Interpretation Process

Lab Interpret

Biological DNA _
Evidegnce Signals —» | Genotype | — | Information

Figure 1. DNA Interpretation Process

The DNA interpretation process is broken down into two transformations (Figure 1).
The goal of each transformation is to preserve as much identification information as
possible. In the first step, a laboratory transforms the biological evidence samples
into DNA signals. The second transformation involves the interpretation of the DNA
signals into genotypes. The TrueAllele Casework software handles this step by
quantitatively interpreting DNA signals using probabilistic genotype modeling.

Mathematical formulas communicate the genotypes as identification information.

1.2 Background Information

There is a wealth of material available from Cybergenetics for learning about the
objective computer interpretation of quantitative DNA evidence. Essential
information is provided in this and other supporting manuals. Additional publications
and presentations are available on the Cybergenetics website at

www.cybgen.com/information.

Newsletters
The best place to begin is with Cybergenetics DNA newsletters, located at

https://www.cybgen.com/news/newsletters/page.shtml. These short articles are

written for the nonscientist. These newsletters introduce TrueAllele Casework and
show the system’s use in court, different validation studies, and comparisons with

human review.
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Publications
An introduction to a DNA likelihood ratio match statistic is found in this short

expository article, located at http://www.cybgen.com/go/ISHI2010.

The operation and significance of the TrueAllele system are described in this peer-

reviewed, scientific validation paper located at http://www.cybgen.com/go/JFS2011.

It is recommended to read this long article over three separate sessions:

1. Introduction, Materials and Methods. These sections teach the underlying princi-
ples of probabilistic genotyping and DNA identification information. They also ex-

plain how to rigorously assess the reliability of any DNA interpretation method.

2. Case Example. A DNA mixture from a real case was analyzed both by man and
machine. The computer's match score was a billion times greater. Ten different
reasons, explored at ten different genetic loci, are examined to explain how com-

puters can preserve the match information that humans discard.

3. Results and Discussion. Computer and human review that were conducted on
the same sixteen DNA mixture casework items are compared. The results show
TrueAllele computer’s reliability and show that the computer is typically a million
times more informative than human. The computer simply makes better use of
the DNA data.

In addition, Cybergenetics researchers have written many other scientific and peer-
reviewed publications about TrueAllele evidence interpretation and how it fully
preserves DNA identification information, located at

http://www.cybgen.com/information/publication/page.shtml.
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Course Lectures
Course materials (videos, slides, transcripts, etc.) are provided about quantitative
DNA mixture interpretation, located at

http://www.cybgen.com/information/courses/page.shtml. The six 20 minute lectures

on "DNA ldentification for Scientists: Basics & Methods" are the starting point for

students desiring a real understanding of scientific DNA interpretation.

Additional References
After this basic introduction, there are scientific presentations about TrueAllele's
methods and results available for review, located at

http://www.cybgen.com/information/presentations/page.shtml. These short, narrated

PowerPoint movies provide a living history of the TrueAllele technology and its

applications as presented at scientific meetings.

1.3 Visual User Interface (VUler)

An analyst installs the TrueAllele VUler software on their Macintosh or Windows
computer to interact with a TrueAllele server. This software allows the analyst to
upload data and requests and download the results that are stored on the TrueAllele
server. Depending on the needs of the analyst, there are three VUler versions

available: Full, Cloud, and Read-only.

Full

This VUler version is available to interact with the laboratory’s in-house TrueAllele
server. The analyst first analyzes their data in the Analyze module, uploads their
data in the Data module, asks interpretation questions in the Request module, and
reviews results in the Review and Report modules. A Tools module is available for
administrative purposes. Many different interfaces and features are present that

allow the analyst to view their data and separated genotypes in detail, ultimately for
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reporting purposes. The accompanying user manuals describe the features of this

VUler version.

Cloud

This VUler version is available to interact with the TrueAllele Cloud database
servers. It lets the analyst upload data for processing on the TrueAllele Cloud
server in the Upload module. After TrueAllele processing is complete, the analyst

downloads interpretation results in the Download module.

Read-only

This read-only version of the TrueAllele VUler software is available for reviewing
TrueAllele results. This version enables the Download module allowing an analyst
to download and review TrueAllele interpretation results. The Read-only version is

useful for administrative or court related purposes.

1.4 System Requirements

For best performance, the recommended system requirements for the TrueAllele

Visual User Interface (VUler) software are:

For Macintosh computers:

OS: Mac OS X 10.14.6 or higher

CPU: Intel x86-64 processor or later

RAM: 8 GB RAM (4 GB RAM minimum)

Storage: 3.4 GB of free hard drive space (5-8 GB for installation)

Display: Screen resolution of 1920 x 1080 (Minimum resolution: 1024 x 768)
Graphics: Hardware accelerated graphics card supporting OpenGL 3.3 with 1 GB

GPU memory is recommended
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For Windows computers:

OS: Windows 7 or later

CPU: Intel or AMD x86-64 or later

RAM: 8 GB RAM (4 GB RAM minimum)

Storage: 3.5 GB of free hard drive space (5-8 GB for installation)

Display: Screen resolution of 1920 x 1080 (Minimum resolution: 1024 x 768)
Graphics: Hardware accelerated graphics card supporting OpenGL 3.3 with 1 GB

GPU memory is recommended
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2 Software Installation (Macintosh)

This section walks through the TrueAllele VUler installation for a Macintosh
computer. A complete TrueAllele Casework installation package includes the MCR
Engine, the Analyze module of the VUler software, and the VUler software itself.
Cybergenetics supplies each part of the package for the complete installation of all

parts. Installation instructions for a Windows computer are found in Section 3.

2.1 MCR Engine

The MCR Engine is an underlying program that powers the graphics and statistical
calculations of the VUIler software. The MCR engine is never independently started

when operating VUler, but the program must be preinstalled for proper operation.

An analyst begins by expanding the zip file
‘“MATLAB_Runtime_R2020b_Update_6_maci64.dmg.zip”, which makes the installer
file “MATLAB_Runtime_R2020b_Update_6_maci64.dmg” available. The analyst
then double clicks that file to begin the installation process. This step may take

several minutes.

On the introduction screen (Figure 2), selecting ‘Next’ advances to the next screen.

TrueAllele VUlIer:
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o () MATLAB Runtime Installer

This application will install MATLAB Runtime.

MATLAB

2020

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. Please see
mathworks.com/trademarks for a list of additional trademarks. Other product or brand
names may be trademarks or registered trademarks of their respective holders.

WARNING: This program is protected by copyright law and international treaties. Copyright
1984-2020, The MathWorks, Inc. Protected by U.S. and other patents. See
MathWorks.com/patents

) MathWorks

Figure 2. Introduction Screen.

The next screen contains a License Agreement file for review (Figure 3). After

reading the file, the analyst selects ‘Next to advance to the next screen.

o [ ) License Agreement

The MathWorks, Inc.
MATLAB RUNTIME LICENSE

IMPORTANT NOTICE
BY CLICKING THE "YES" BUTTON BELOW, YOU ACCEPT THE TERMS OF THIS LICENSE. IF YOU ARE NOT WILLING
TO DO SO, SELECT THE "NO" BUTTON AND THE INSTALLATION WILL BE ABORTED.

1. LICENSE GRANT. Subject to the restrictions below, The MathWorks, Inc. ("MathWorks") hereby grants to you,
whether you are an individual or an entity, a license to install and use the MATLAB Runtime ("Runtime"), solely
and expressly for the purpose of running software created with the MATLAB Compiler (the "Application
Software"), and for no other purpose. This license is personal, nonexclusive, and nontransferable.

2. LICENSE RESTRICTIONS. You shall not modify or adapt the Runtime for any reason. You shall not
disassemble, decompile, or reverse engineer the Runtime. You shall not alter or remove any proprietary or
other legal notices on or in copies of the Runtime. Unless used to run Application Software, you shall not rent,
lease, or loan the Runtime, time share the Runtime, provide service bureau use, or use the Runtime for
supporting any other party's use of the Runtime. You shall not sublicense, sell, or otherwise transfer the
Runtime to any third party. You shall not republish any documentation which may be provided in connection

Do you accept the terms of the license agreement? © Yes No
) MathWorks

Figure 3. License Agreement.

Next, the analyst selects a folder to install the software in the Folder Selection

window (Figure 4). The analyst should ensure that the folder chosen for installation
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allows read/write access. If not, the analyst uses the ‘Get info’ window to set the

correct permissions.

[ NON ) Folder Selection

Choose installation folder:

/Applications/MATLAB/MATLAB_Runtime Browse... MA’[‘L AB

RUMTIME

Restore Default Folder R2020b

) MattWorks

Figure 4. Folder Selection Screen

In the Confirmation window (Figure 5), the analyst selects ‘Install’ to begin the
installation process. When prompted, the administrator user name and password is

entered.

[ ] [ ] Confirmation

Installation folder:

/Applications/MATLAB/MATLAB_Runtime/v99 Wl ‘LA Bs

Installation Size: 5,633 MB

R2020b

Products:
MATLAB Runtime 9.9

) MathWorks:

Figure 5. Confirmation Screen.
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If the Product Configuration Notes screen appears (Figure 6), clicking ‘Next’ will

continue installation. Changing the path noted on the screen is not needed to run
the VUler software.

| NON J Product Configuration Notes

On the target computer, append the following to your DYLD_LIBRARY_PATH environment

e MATLAB
/Applications/MATLAB/MATLAB_Runtime/v99/runtime/maci64:/Applications/MATLAB/M RUNTIME
ATLAB_Runtime/v99/sys/os/maci64:/Applications/MATLAB/MATLAB_Runtime/v99/bin/ R2020b

maci64:/Applications/MATLAB/MATLAB_Runtime/v99/extern/bin/maci64

If MATLAB Runtime is to be used with MATLAB Production Server or MATLAB Web App
Server, you do not need to modify the above environment variable.

J MathWorks:

Figure 6. Product Configuration Notes.

Once installation is complete, selecting ‘Finish exits the installer (Figure 7).

[ ] @ Installation Complete

Installation is complete.

MATLAK

R2020b

B ) MathWorks

Figure 7. Installation Complete.
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2.2 Analyze

The Analyze module transforms the raw sequencer files into quality checked peak
data for upload to the TrueAllele Server. Installing the Analyze module installs the
program itself and creates the user environment. If Analyze is already installed on a
Viewstation, the analyst should remove this application and corresponding
‘trueallele’ folder (found in Documents) before upgrading the program, saving any

customized files elsewhere, if necessary.

Program Installation
The analyst starts by expanding on the zip file “Analyze.pkg.zip”, which makes the
package file “Analyze.pkg” available. The analyst then control clicks on the package

file and selects Open to begin the installation process.

On the introduction screen (Figure 8), selecting ‘Continue’ advances to the next

screen.
[ ] & Install
Welcome to the Installer
® Introduction You will be guided through the steps necessary to install this
software.
Continue
4
Figure 8. Introduction Screen.
TrueAllele VUlIer:
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If prompted, the analyst selects a destination to install the software in the

Destination Select window. Most likely this installation will be for all users of the

computer.

A custom install screen may appear (Figure 9). By leaving all boxes checked, the
analyst can upgrade the Analyze software and templates. Selecting ‘Continue’

advances to the next screen.

[ ] & Install

Custom Install on “Macintosh HD"

Package Name Action Size
Introduction Upgrade 45MB
Destination Select TrueAllele Upgrade 62.8 MB

® Installation Type

Space Required: 67.3 MB Remaining: 70.47 GB

Go Back Continue

Figure 9. Custom Install.

A standard install is automatically available. The analyst begins installation by

selecting ‘Install’ (Figure 10). When prompted, the administrator user name and

password is entered.

TrueAllele VUlIer:
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[ ) @ Install

Standard Install on “Macintosh HD"

Introduction This will take 67.3 MB of space on your computer.

Destination Select Click Install to perform a standard installation of this software

e Installation Type on the disk “Macintosh HD".

Change Install Location...

Go Back Install

Figure 10. Standard Install.

After the installation is complete, selecting ‘Close’ finishes the process (Figure 11).

o & Install

The installation was completed successfully.

Introduction

Destination Select
Installation Type
Installation

® Summary

The installation was successful.

The software was installed.

Close

Figure 11. Installation complete.

This completes the installation of the Analyze module. The analyst’s data can now

be processed.

TrueAllele VUlIer:
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User Environment

The user environment includes all necessary templates and settings for processing
the data in Analyze and is contained in a ‘trueallele’ folder. After installation, the
‘trueallele’ folder appears in the Documents folder of the user account. For
example, if a user is logged in as ‘DNA’, the ‘trueallele’ folder will be created in

DNA’s documents folder.

2.3 VUler

The VUler software allows the analyst to upload and ask questions of the case data
and then review the answers produced by the TrueAllele computer. If VUler is
already installed on a Viewstation, the analyst should remove this application and
save any customized preference files (such as the connect.txt or report.txt files)

elsewhere on the computer before updating VUler, if necessary.

The analyst starts by expanding the zip file “VUler.pkg.zip”, which makes the
package file “VUler.pkg” available. The analyst then control clicks on the package

file and selects open to begin installation.

On the introduction screen (Figure 12), selecting ‘Continue’ advances to the next

screen.
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o & Install

Welcome to the Installer

Welcome to Cybergenetics TrueAllele® VUler™ Installer

® Introduction
This Installer will install Cybergenetics TrueAllele Visual User Interface
(VUler) software. The VUler is used to process and review your STR
DNA data using Cybergenetics TrueAllele Technology.

Cybergenetics TrueAllele VUler will let you check data quality, decide
which data to use, set up cases for TrueAllele interpretation, initiate
TrueAllele calculation of genetic profiles and their matches, and visually
review genetic data and TrueAllele results.

This Installer guides you through the steps necessary to install the

bundled content for TrueAllele VUler. To get started, please click
Continue.

Continue

Figure 12. Introduction Screen.

The next screen contains a Read Me file for review (Figure 13). After reading the

file, the analyst selects ‘Continue’ to advance to the next screen.

o @ Install

Important Information

TrueAllele Technology: VUler™ Software
Introduction
Visual User Interface (VUler) for TrueAllele Review
® Read Me Cybergenetics
2022

Client / Server Architecture
TrueAllele Scientific Calculator (TASC™) Server

Cybergenetics TrueAllele Scientific Computer (TASC™) is a multi-
processor supercomputer instrument for inferring and matching DNA
profiles. The TASC instrument holds STR data on a central coordinating
database. When asked specific forensic questions about a case, the
multiple computers on the TASC system automatically interpret these
data and infer genetic profiles. The TASC DNA matcher then compares
these profiles for human identity. The computed TrueAllele profiles and
matches are recorded on the database.

ATASC instrument can process hundreds of evidence samples (single
source and mixtures) in a working day. TrueAllele schedules the
"autoloading" of the interpretation requests in priority order, so that cases

Print... Save... Go Back Continue
Figure 13. Read Me.
TrueAllele VUler: Cybergenetics © 2022 Page 18 of 45
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Next is the license agreement (Figure 14). After selecting ‘Continue’, a prompt
appears to confirm agreement with the license (Figure 15). The analyst proceeds by

selecting ‘Agree’.

[ ) @ Install

Software License Agreement

Introduction End-User License Agreement for TrueAllele Technology
Cybergenetics Terms and Conditions
Read Me
O MEnED The "Agreement" refers to the Terms and Conditions described herein.
The "Company" is Cybergenetics, Corp., a corporation duly organized
and existing under the laws of the Commonwealth of Pennsylvania
and having its principal office at 160 North Craig Street, Suite 210,
Pittsburgh, Pennsylvania 15213, USA.
The "Effective Date" is the date on which Payment is made, the
Technology is used, or the Rights are exercised, whichever happens
first.
The "Hardware" is the computer hardware and associated machinery of
the TrueAllele® system.
The "Location" is the laboratory or office where the User is located.
The "Patents" shall mean all patents that are owned or licensed by the
Company, and all United States and foreign patents and/or patent
applications claiming priority from such patents, and shall apply solely
to forensic casework of DNA samples.
The "Payment" is the mutually agreed upon amount paid by the User to
the Company.
The "Rights" shall mean the right to practice the TrueAllele® Technology.
Than MO Afhiinmall in Hhn ammamisban anfhiinea and anmanintad Aanantabian
Print... Save... Go Back Continue
4
Figure 14. License Agreement.
@ Install
Software License Agreement
Introduction End-User License Agreement for TrueAllele Technology
Cybergenetics Terms and Conditions
Read Me
® Lic inzed
To continue installing the software you must agree to the terms of the ania
software license agreement. 210,
Click Agree to continue or click Disagree to cancel the installation and quit the
the Installer. ens
ty of
Read License Disagree Agree 1
| the
atent
applications claiming priority from such patents, and shall apply solely
to forensic casework of DNA samples.
The "Payment" is the mutually agreed upon amount paid by the User to
the Company.
The "Rights" shall mean the right to practice the TrueAllele® Technology.
T O N 0% (SIS, i SR, T AT R S 00 N
Print... Save... Go Back Continue
4
Figure 15. License Agreement.
TrueAllele VUlIer: .
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If prompted, the analyst selects a destination to install the software in the
Destination Select window. Most likely this installation will be for all users of the

computer.

A standard install is automatically available (Figure 16). The analyst begins the
installation by selecting ‘Install’. When prompted, the administrator user name and

password is entered.

[ ] & Install
Standard Install on “Macintosh HD"

Introduction This will take 8.8 MB of space on your computer.

Read Me Click Install to perform a standard installation of this software
licence on the disk “Macintosh HD".
Destination Select

® Installation Type

Change Install Location...

Go Back Install

Figure 16. Standard Install.

After the installation is complete, selecting ‘Close’ finishes the process (Figure 17).

The VUler software is now installed and available for use.

TrueAllele VUlIer:
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[ ] « Install

The installation was completed successfully.

Introduction

Read Me
License
Destination Select

lnstalaton ype The installation was successful.

Installation .
The software was installed.
® Summary

Close

Figure 17. Installation complete.

Once VUler has been installed, the analyst uses the icon in the Applications folder to

start the program. This icon can be added to the Dock, as desired.

The user account must allow permissions to read/write to the /Library/TrueAllele
folder to start the software. The analyst uses the ‘Get info’ window to set the correct

folder permissions.

TrueAllele VUlIer:
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3 Installation (Windows)

The steps for installing the MCR Engine, Analyze, and VUIler software on a 64-bit
Windows computer are found in this section. As with a Macintosh, the MCR engine
must be installed first to allow the VUler software to be used. Also, the analyst
should note that before updating any of the programs, the customized user
directories and preferences could be saved elsewhere on the computer in order to

preserve and reinstate them after an update.

3.1 MCR Engine

An analyst begins by expanding the zip file

‘“MATLAB_Runtime _R2020b_Update 6 win64.zip”, which makes the folder
‘“MATLAB_Runtime _R2020b_Update 6 win64” available. Inside this folder, the
analyst then double clicks on the executable file “setup.exe” to begin the installation

process.

On the introduction screen (Figure 18), selecting ‘Next’ advances to the next screen.

TrueAllele VUlIer:
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[ ; ESREERT)
4\ MATLAB Runtime Installer —— =

This application will install MATLAB Runtime.

R2020b

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. Please see
mathworks.com/trademarks for a list of additional trademarks. Other product or brand names
may be trademarks or registered trademarks of their respective holders.

WARNING: This program is protected by copyright law and international treaties. Copyright
1984-2020, The MathWorks, Inc. Protected by U.S. and other patents. See MathWorks.com/patents

) MathWorks*

Figure 18. Introduction Screen.

The next screen contains a license agreement for review (Figure 19). After reading
and accepting the agreement, the analyst selects ‘Next’ to advance to the next

screen.

<
4\ License Agreement E=NEERT

The MathWorks, Inc. e

>

MATLAB RUNTIME LICENSE

m

IMPORTANT NOTICE | 8
BY CLICKING THE "YES" BUTTON BELOW, YOU ACCEPT THE TERMS OF THIS LICENSE. IF YOU ARE NOT WILLING TO DO
SO, SELECT THE "NO" BUTTON AND THE INSTALLATION WILL BE ABORTED.

1. LICENSE GRANT. Subject to the restrictions below, The MathWorks, Inc. ("MathWorks") hereby grants to you, whether
you are an individual or an entity, a license to install and use the MATLAB Runtime ("Runtime"), solely and expressly for
the purpose of running software created with the MATLAB Compiler (the "Application Software"), and for no other
purpose. This license is personal, nonexclusive, and nontransferable.

2. LICENSE RESTRICTIONS. You shall not modify or adapt the Runtime for any reason. You shall not disassemble,

: decompile, or reverse engineer the Runtime. You shall not alter or remove any proprietary or other legal notices on or in
copies of the Runtime. Unless used to run Application Software, you shall not rent, lease, or loan the Runtime, time share

' the Runtime, provide service bureau use, or use the Runtime for supporting any other party's use of the Runtime. Yo i
|

P s n P S - S P L L P

Do you accept the terms of the license agreement? © () Ne

) MathWorks*

Figure 19. License Agreement.
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Next, the analyst clicks ‘Next’ in the Folder Selection screen to install the software in
the default destination folder (Figure 20).

-
4\ Folder Selection

- m@g

Choose installation folder:

C:\Program Files\MATLAB\MATLAB Runtime

MATLAB

Restore Default Folder ]

R 2026[:3-

N

) MathWorks*

Figure 20. Folder Selection Screen.

If prompted, the analyst confirms the creation of the destination folder by selecting
‘Yes’ (Figure 21).

4\ Folder Selection

The destination folder C:\Program Files\MATLAB\MATLAB Runtime\ does not exist.
Would you like to create it? l

Figure 21. Folder Selection Confirmation.

In the Confirmation window (Figure 22), the analyst selects ‘Install’ to begin the

installation process. If prompted, the administrator user name and password is

entered.
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-
4\ Confirmation

S | B [ |

Installation folder:
C\Program Files\MATLAB\MATLAB Runtime\v39

Installation Size: 6,358 MB

Products:
MATLAB Runtime 9.9

Cancel

MATLAB

R2020b

) MathWorks*

Figure 22. Confirmation Window.

Once installation is complete, selecting ‘Finish’ exits the installer (Figure 23).

-
4\ Installation Complete

ST

Installation is complete.

Cancel

R2020b

) MathWorks-

Figure 23. Installation Complete Screen.
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3.2 Analyze

To install the Analyze module on a Windows computer, the analyst starts by
expanding the zip file “Analyze_64bit.exe.zip”, which makes the executable file
“Analyze_64bit.exe” available. The analyst then double clicks on the execute file to

begin the installation process.

On the introduction screen (Figure 24), selecting ‘Next’ advances to the next screen.

) TrueAllele - InstaliShield Wizard [

Welcome to the InstallShield Wizard for TrueAllele

The InstallShield(R) Wizard will install TrueAllele on your computer. To continue, dlick Next.

WARNING: This program is protected by copyright law and
international treaties.

Cybergenetics

Back [ Next > ] [ Cancel ]

Figure 24. Introduction Screen.

The next screen contains a license agreement for review (Figure 25). After reading
and accepting the agreement, the analyst selects ‘Next’ to advance to the next

screen.
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ﬁ TrueAllele - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

End-User License Agreement for TrueAllele Technology ||

The "Agreement" refers to the Terms and Conditions described
herein.

The "Contract Term" begins at the Effective Date of this
Agreement.

The "Effective Date" is the date on which Payment is made.
The "Licenseg" is the government agency operati_ng under the .

1 accept the terms in the license agreement:

() I do not accept the terms in the license agreement

@

InstallShield

[ < Back J[ Next > ] [ Cancel J

Figure 25. License Agreement.

Next is the customer information screen (Figure 26). After entering the appropriate

information and selecting the user(s) to install the application for, the analyst selects
‘Next’ to proceed.

4 TrueAllele - InstallShield Wizard [

Customer Information \
Please enter your information. :

User Name:
jona

Organization:
ICybergeneﬁcs

Install this application for:

@ Anyone who uses this computer (all users)
() Only for me (DNA)

InstallShield

[ <Back |[ mext> ][ cancel |

T}

Figure 26. Customer Information Screen.
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On the next screen, the analyst chooses the default setup type and clicks ‘Next’ to

continue (Figure 27).

%) TrueAllele - InstallShield Wizard [
Setup Type \
Choose the setup type that best suits your needs. :
Please select a setup type.

All program features will be installed. (Requires the most disk
space.)

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstallShield

[ < Back ][ Next> | [ Cancel ]

Figure 27. Setup Type Window.

On the ready to install screen (Figure 28), the analyst selects ‘Install’ to begin the

Analyze installation. If prompted, the administrator user name and password is

entered.
4 TrueAllele - InstaliShield Wizard = 55|
Ready to Install the Program \

The wizard is ready to begin installation. :
Click Install to begin the installation.
If you want to review or change any of your installation settings, dlick Back. Click Cancel to
exit the wizard.

InstaliShield -

[ <Back |[  mmstal ][ cancel |
—_—
Figure 28. Ready fo Install.
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After the installation is complete, selecting ‘Finish’ completes the process (Figure
29). This completes the installation of the Analyze module, and data can now be

processed in the Analyze module.

) TrueAllele - InstallShield Wizard (o

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed TrueAllele.
Click Finish to exit the wizard.

Figure 29. Installation Complete.

If necessary, the analyst should copy the ‘trueallele’ folder to every user’'s ‘My
Documents’ directory and add or replace any custom user directories or templates to

this ‘trueallele’ folder.

Updating Analyze

Before updating Analyze, the analyst should first copy any customized files to be
kept from the C:/Users/username/My Documents/trueallele/system folder. Then, the
analyst should uninstall any older versions of Analyze by using the Add or Remove
Programs feature. After removing the software, the analyst should delete the

C:/ Users/username/My Documents/trueallele directory for every user. Then,

Analysis can be updated following the same steps outlined previously.
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3.3 VUler Software

To install the VUler software, the analyst starts by expanding the zip file
“VUler_64bit.exe.zip”, which makes the package file “VUler_64bit.exe” available.

The analyst then double clicks on the executable file to begin installation.

On the introduction screen (Figure 30), selecting ‘Next’ advances to the next screen.

- \
18] VUler - InstallShield Wizard S5

Welcome to the InstallShield Wizard for VUler

The InstallShield(R) Wizard will install VUIer on your computer, To continue, dick Next.

TrueAllele Technology is protected by US patent
CYb ergene-t, cs 10,489, 233. Copyright 1997-2022 Cybergenetics.

| SNext 1| Cancel

Figure 30. Introduction Screen.

The next screen contains a license agreement for review (Figure 31). After reading
and accepting the agreement, the analyst selects ‘Next’ to advance to the following

screen.
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ﬁ VUIer - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

End-User License Agreement for TrueAllele Technology (3

The "Agreement" refers to the Terms and Conditions described
herein.

The "Contract Term" begins at the Effective Date of this
Agreement. 1
The "Effective Date" is the date on which Payment is made.

The "Licensee" is the government agency operating under the -

@1 accept the terms in the license agreement: Print

() I do not accept the terms in the license agreement

InstallShield

[ <Bak [ >Next ][ cancel

Figure 31. License Agreement.

Figure 32 shows the customer information screen. After entering the appropriate

information and selecting the user(s) to install the application for, the analyst selects
‘Next’ to proceed.

#5) VUIer - InstaliShield Wizard M

Customer Information \
Please enter your information. \

User Name:
fpna

Organization:
ICybergeneﬁcsl

Install this application for:

(@ Anyone who uses this computer (all users)
(©) Only for me (DNA)

InstallShield

[ < Back ][ > Next ] [ Cancel ]

Figure 32. Customer Information Screen.
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On the next screen, the analyst chooses the default setup type and clicks ‘Next’ to

continue (Figure 33).

1) VUIer - InstaliShield Wizard | 23|

Setup Type \
Choose the setup type that best suits your needs.

Please select a setup type.

@ Complete
All program features will be installed. (Requires the most disk
space.)

(") Custom

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

InstallShield

[ < Back ][ > Next ] [ Cancel

Figure 33. Setup Type Window.

On the ready to install screen (Figure 34), the analyst selects ‘Install’ to begin the

VUler installation. If prompted, the administrator user name and password is

entered.
5] VUler - InstaliShield Wizard | 25
Ready to Install the Program \

The wizard is ready to begin installation.
Click Install to begin the installation.
If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstallShield

[ <Bak [ mstal ][ cancel
Figure 34. Ready fo Install.
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After the installation is complete, selecting ‘Finish’ completes the process (Figure

35). The VUler software is now installed and available for use.

1) VUler - InstaliShield Wizard S
InstallShield Wizard Completed
The InstallShield Wizard has successfully installed VUIer. Click
Finish to exit the wizard.

Cancel

Figure 35. Installation Complete.
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4 Software Function

This section covers the starting the VUler program including information about the
license key and Module Chooser. The Appendix » Diagnostic Support covers an
alternative method for starting the program. In addition, this section discusses

connecting to a database and closing the VUler program.

4.1 License

After installing VUler, the analyst starts the program by clicking on its icon (Figure
36). The application is located in the Dock or Applications folder on a Macintosh or

from the Desktop shortcut or Start Menu on a Windows computer.

Figure 36. VUler icon.

A valid license key is required to use the VUler software. Cybergenetics provides
this license key. When starting VUIler for the first time, a dialog box appears
prompting the analyst to enter a license key (Figure 37). This key is only entered
the first time the software is started. VUler will open to the Module Chooser after a

valid license key is entered.

If the software fails to start after entering a valid license key on a Macintosh, the

analyst should verify that the /Library/TrueAllele folder allows read/write
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permissions. If not, the analyst should enable the permissions for all enclosed files

and folders.

® O O License Key

Please enter icense key
l |

OK Cancel

Figure 37. License key input dialog box.

4.2 Module Chooser

The Module Chooser opens after a valid license key is entered. This interface is
where the analyst uploads data and downloads results. The interface is different for

each of the VUler versions.

In the Full VUIler version, all modules are available for use (Figure 38).

[ ) Choose Module
App

Cybergenetics

TrueAllele® Technology

Analyze Data Request

=

ooo
ooo V
ooo

Review Report Tools

Figure 38. Full Module Chooser.
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In the VUler Cloud version, both the Upload and Download modules are available
(Figure 39).

8 00 Choose Module
App

Cybergenetics

TrueAllele® Technology

Upload Download

Figure 39. Cloud Module Chooser.

For the VUler Read-only version, only the Download module is available for

reviewing results (Figure 40).

8 00 Choose Module
App

Cybergenetics

TrueAllele® Technology

Download

Figure 40. Read-only Module Chooser.
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4.3 Connecting to a Database

In the VUler program, the Connect window allows an analyst to connect to a
database or to switch to a different database at any time during the TrueAllele
process. The analyst opens the Connect window by selecting the Database »

Connect menu option in any VUler module.

Connect window

To connect, an analyst selects the desired server System from the dropdown menu
(this action fills in the System field as well). The analyst then enters a username
and password under the Authenticate heading and clicks ‘Verify’. A blue check mark
is present when the connection is verified, and the Connect window (Figure 41) will

automatically close.

[ JON Connect
Database

Select Database T
System system.information

Database project
Authenticate

Username user

Password

Verify
Status
o Database connection required
Close Clear

Figure 41. The Connect window.
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Clearing Information
To clear all of the information entered in the Connect window fields and exit the
database, the analyst can use the ‘Clear’ button at the bottom right of the window.

When finished with this process, the ‘Close’ button will close the window.

Connection Difficulties
If a red “X” appears with the message “Database Connection Failure” when clicking
the ‘Verify” button instead of the blue check or the window closing, the connection to

the database was not successful.

This message could mean that incorrect user account information was entered. The
user name and password are case sensitive, so the analyst should first check that

the information was entered correctly.

4.4 Closing the VUler Program

The TrueAllele Server accepts a limited number of concurrent user connections. An
analyst must properly end user sessions so the connection is open for another

analyst. There are two main methods of ending a user session.

When finished using the VUler software, the analyst can close the program by
selecting App » Quit. This will close the program and automatically log out of any

current connections.

If an analyst does not want to close the VUler program but wishes to end the current
session, the analyst can logout of a TrueAllele World. From within any module,
selecting Database » Logout will log an analyst out of the current database, making

the connection available for other users.
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To close a window within a module, the analyst selects File » Close. To close a
module and go back to the Module Chooser, an analyst selects File » Exit Module.
This selection brings up a dialog box asking an analyst if they wish to exit the
particular module and choose a different one. Here an analyst selects “Yes” to exit

or “Cancel” to remain in the current module.
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Appendix

This appendix is designed to provide specific information that may help in using the

TrueAllele VUler software. A glossary of common terms is also provided.

Spinning Wait Cursor

,
9 Spinning Wait Cursor

The spinning wait cursor is equivalent to the hourglass icon on a Windows
computer. This icon indicates that TrueAllele is retrieving data from the database.
This cursor is only active when it is held over a VUler window. If the mouse is
moved off of the window (for example, to the desktop), the cursor will go back to the

normal pointer.

View Menu

In several modules of the VUIer program, there is a View Menu. This menu allows
the analyst to change the window sizing options for modules that have more than
one interface window open at a time. The View Menu includes options for
automatically sizing and positioning the interfaces as well as making the interface
text larger and smaller. There are also toolbar buttons that allow the analyst to
position the interface windows on the screen (Figure 42), where the white portion of
the icon indicates where the window will be positioned. In addition, keyboard
shortcuts exist for making interface text larger (38=) and smaller (38-) (ctrl= and

ctrl— for Windows).

TrueAllele VUlIer:

Getting Started Cybergenetics © 2022 Page 40 of 45



=00 0OHHA O

Figure 42. View Icons. These icons position the active interface window to the position on the screen
denoted by the white part of the square.

Diagnostic Support

To aid in diagnostic support of the VUler program, an alternate means of starting the
program is available. This method is not routinely used but is available to aid in

support calls to Cybergenetics.

Macintosh support
On a Macintosh, the analyst opens a Terminal window by selecting the Terminal

icon (Figure 43) from the Dock or Applications/Utilities folder.

Figure 43. Terminal icon.

A blank Terminal window opens (Figure 44), displaying the computer’'s name and a

command prompt.

TrueAllele VUlIer:

Getting Started Cybergenetics © 2022 Page 41 of 45



8 O O ¢ dna — bash — 80x24 v

Last login: Fri Mar 27 10:26:45 on ttys@001
Pinguino:~ dna$ I

Figure 44. A blank Terminal window.

In the Terminal window, the analyst copies and pastes the path:
/Applications/VUIer.app/Contents/Mac0S/prelaunch
And then hits the enter key (Figure 45).

e 00 £ dna — bash — 80x24 .
Last login: Fri Mar 27 10:26:45 on ttys@01l
Pinguino:~ dna$ /Applications/VUIer.app/Contents/Mac0S/prelaunch I

Figure 45. A Terminal window with the path filled in.
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Windows support
On a Windows computer, the analyst opens a Command Prompt window by

selecting the program from the computer.

A blank Command Prompt window opens (Figure 46), displaying the computer

user's name and a command prompt.

C:\Windows\system32\cmd.exe E== lﬂ[@

Microsoft Windows [Uersion 6.1.76011]
Copyright <(c)> 2809 Microsoft Corporation. All rights reserved.

m| »

C:\Users\cyhergenetics>

Figure 46. A blank Command Prompt window.

In the Terminal window, the analyst copies and pastes the path:

C:\Program Files\VUIer\VUIer.exe

And then hits the enter key (Figure 47).
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C:\Windows\system32\cmd.exe =R [EI@

Microsoft Windows [Uersion 6.1.760811]
Copyright {(c)> 2089 Microsoft Corporation. All rights reserved.

m|»

C:\Users\cybergenetics>"C:\Program Files\UUIer\UUler.exe"

Figure 47. A Command Prompt window with the path filled in.

By starting the VUler program this way, diagnostic messages that are displayed
during software operation appear in the Terminal window. These messages can be

copied and pasted into an email to Cybergenetics if support is required.

Glossary

This glossary presents some commonly used terms. The term of interest is

italicized.
Evidence data comprise STR experiments on a set of samples.

An observed genotype is a probability distribution over a set of possible allele pairs

at a locus.

The identification hypothesis is that a suspect contributed their DNA to an evidence

sample.

Identification information is the logarithm of the identification LR.
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A likelihood function determines the fit between data and model. (More formally, it is

the probability of the data given a model.)
An identification likelihood ratio (LR) is the weight of evidence in favor of an
identification hypothesis. The LR can be calculated as a ratio of two match

probabilities.

A Markov chain is a visual history of the search that the system performs in order to
find the best-fit model for the data.

A match occurs when two genotypes are equal.

A match probability is the probability of a genotype match.

A mixture is a DNA sample that contains two or more individual contributors.

A probability model is a mathematical formulation that accounts for observed data.

A validation study assesses the efficacy and reproducibility of an interpretation

method for extracting identification information from DNA data.

TrueAllele VUlIer:

Getting Started Cybergenetics © 2022 Page 45 of 45



